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This experiment is intended to demonstrate properties of the Fourier transform by means
of an experimental setup on an optical bench. Furthermore, properties of the periodic grating
used in the experiment are to be determined.

The tasks marked as �Preparation� are to be done at home prior to the execution of the
experiment (and will be inquired upon if necessary) and the results, as far as possible, should
be included in the lab report. Tasks marked as �Exercise� refer to the data obtained during
the experiment. Especially the experimentation with the Java applets is very informative, and
therefore a necessary part of the preparation. If you do not have the possibility to run the
applets, please contact the instructor of the experiment!

Prior knowledge: Geometrical optics, wave optics, Fourier transform, laser, CCD camera,
error calculus, experimental skills
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1 Introduction

The importance of the Fourier transform in physics and computer science cannot be overstated.
One of its implementations, the Fast Fourier Transform (FFT), is sometimes referred to as the
most commonly used algorithm on the planet.

The Fourier transform is an integral transform that is suitable to decompose e.g. a time-
dependent signal into its frequency components. The resulting data then can be analyzed with
regard to which frequency components are dominant and which are not.

A special case of the Fourier transform is the Fourier series. Here, a periodic function is
represented by the sum of sine and cosine functions.

Preparation 1 Experiment with the �Fourier Series� Java applet1 (this applet can also be ob-
tained as a zip archive from the instructor). Try to develop a feeling for how the addition and
subtraction of individual Fourier components a�ects the result. Calculate the relative amplitudes
of the �rst 8 coe�cients of the Fourier expansion of a sawtooth function:

f(t) =
2h

π

[
sinωt− 1

2
sin 2ωt+

1

3
sin 3ωt∓ · · ·

]
(1)

and compose a sawtooth function �by hand� (please provide a screenshot and the coe�cients
in your lab report).

How does the composition of the Fourier components change when a function is shifted along
the x-axis? When does the Fourier series consist exclusively of sine and cosine components?

Generally speaking, the term �frequency� refers to the respective physical quantity known as
such. In this experiment, however, no temporal signal is turned into a frequency signal. Instead,
a two-dimensional image is decomposed into Fourier components, which are subsequently ma-
nipulated and then transformed back again to observe various e�ects. Therefore, one typically
speaks here of �spatial frequencies�.

Preparation 2 Experiment with the �Discrete Fourier Transform Viewer� Java applet2. Here
you can upload an image (right menu bar, �Load Image�), Fourier-transform it, manipulate the
transform (second drop-down menu, �Mouse = Draw [shape]�), and observe the e�ects on the
inverse transformation.

How does the Fourier transform of a delta component (one white pixel in an otherwise black
image) look like? What information (large / small structures) is encoded at di�erent positions
in the Fourier plane? How do high- and low-pass �lters work? Find common (and I mean
common!) examples of the application of the Fourier transform.

2 Experiment Setup

The beam of light from a helium-neon laser (λ=632.8 nm) is widened via a beam expander and
then is used to illuminate a cross grating G. The lens L1 in the distance fL1 produces an image
of the grating in the focal plane. This is the Fourier plane in which the Fourier transform of
the grating can be manipulated. After de�ection by two plane mirrors, a second lens L2 takes
care of the inverse transformation from the Fourier plane. A CCD camera records the resulting
image and displays it on a screen. Between the beam expander and the grating is a polarization
�lter, which can be used to regulate the intensity of the light.

1http://www.falstad.com/fourier
2http://www.falstad.com/�t/
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Figure 1: Schematic representation of the grid used in the experiment. The distance between the line centers is 250µm,

the periodicity is 1000µm, the width of the thin lines is 15µm and the width of the thick lines is to be determined in the

experiment by measurement of the structure function.

The cross grating G consists of a sequence of three thin (15µm) lines and a thicker line,
whose exact width is to be determined in the experiment. All line centers have a distance in x-
and y-direction of 250µm from each other. Thus, the lattice constant is d = 250µm, whereas
the periodicity of the lattice is 1000µm.

Preparation 3 Inform yourself about the way a He-Ne laser and a CCD camera works. What
is a possible reason if there is no image visible on the screen? Why can the intensity of the
laser light be altered using a polarization �lter (research whether the light from a He-Ne laser
is polarized)? How can you tell if this particular laser is polarized or whether the light is �rst
polarized in the polarizer?

Unlike during the imaging of a conventional light source, we here can observe e�ects which
are due to the coherence of the laser light. Since two light beams emanating from di�erent points
of the lattice have a stable relative phase, the interference pattern resulting from them is stable
as well. In the focal plane of L1, this stable interference of the numerous photon beams creates
the Fourier transform of the grating, and with the help of a second lens the original image can
be restored.

3 Experiment

3.1 Setup

Set up the �rst part of the experiment as shown in �gure 2: laser - polarizing �lter - grating -
lens L1 - screen. If the distances of the components are chosen appropriately, you will see the
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Figure 2: Left: Overview of the workspace. right: First setup. On the screen you should see the Fourier transform of the

grid, which is dominated by a cross of points.

Fourier transform of the grating on the screen.

Exercise 1 Describe the pattern you observe. Then illuminate the grid with the sodium-vapor
lamp. To do this, place the lamp directly in front of the polarizing �lter and move the grating,
lens and screen an appropriate distance to the left. Describe the change in the image and explain
your observation.

Now remove the screen and assemble the other components of the experiment - the plane
mirror, the lens L2 and the camera, so that you can see the grating on the screen (Figure 3). If
necessary, the intensity of the laser light can be regulated with the polarizing �lter. Then place
the mask holder into the Fourier plane. The more precise you position the mask holder in x,y
and z, the better the results will be in the following part of the experiment.

Figure 3: Second setup. left: With this setup and suitably dimmed laser you should see an image of the grid on the

monitor. right: The consequences of the manipulation with masks in the Fourier plane can be observed on the monitor.

3.2 Experiment Part A

Using the masks (Figure 4), you can now manipulate the part of the Fourier transform which
is transformed back by L2. Hold a piece of paper directly behind the aperture to verify which
orders are still included in the inverse transformation.

1. MA: Block out higher orders. For the interpretation remember your experiments with the
2D Java applet.
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Figure 4: The masks used in the experiment.

2. MB: Block out the zeroth order. Consider which physical quantity is manipulated in the
Fourier plane, and which is which one is registered by the CCD camera.

3. MC: Block out the di�raction cross.

4. MD: Block out all orders with (2m+ 1, 2n+ 1), m,n = 0,±1,±2, . . . . Consider what the
Fourier transform of a di�erent (narrower/wider) grid would look like.

5. ME: Block the zeroth and higher orders (here only the maxima withm,n = ±1 are allowed
to pass, which requires skillful adjustment). With the help of paper snippets, additionally
block out the remaining maxima (pairwise).

Exercise 2 Describe exactly what pattern you observe on the screen after inserting each mask.
Try to explain how it comes to the observed e�ect.

3.3 Experiment Part B

The interference pattern of a grating can be regarded as the multiplication of two functions.
The �rst function represents the interference image of a grating consisting of in�nitely narrow
lines (=idealized grating), and the second function represents the distribution of the light as it
results from the di�raction by a single slit. The intensity distribution of the light in the Fourier
plane allows one to draw conclusions about the width of the lines of the grating. By precisely
measuring the intensities of the interference maxima in this part of the experiment, the thickness
of the broader lines of the grating are to be determined here.

This measurement can only be perfomed beyond the �rst minimum of the structure function,
between the between the 23rd and 31st maximum of the interference image, as here the structure
function is fairly strongly dependent on the thickness of the broad lines of the grating. On the
other hand, the intensity of the maxima in this area is rather low, and an intensity measure-
ment without prior knowledge of the positions of the maxima will be di�cult. Therefore some
preparatory steps are are necessary, which will be explained in the following section.

3.3.1 Recording the interference pattern

Place the lens L1 directly in front of the grating, and bring the partially transparent screen into
the Fourier plane. Then place the camera in the mounting provided between the screen and the
mirror and attach the remote release (Figure 6). The monitor is no longer needed and can be
switched o�.
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Figure 5: Top: Intensity pro�le of an idealized grid with in�nitely thin lines; middle: Intensity pro�le of a single slit;

bottom: Intensity pro�le of a real grating. For clari�cation, the curve from the middle �gure is also included here.

Figure 6: Third setup. Note that the lens L1 is directly in front of the grating.
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Now choose the maximum zoom level on the camera and select an aperture of f/11. Take
a few sample exposures of the screen (with the laser switched o�!), varying the camera focus.
Repeat this until you have achieved the optimum focus in the area of the screen.

Preparation 4 Which property is expressed by the f-number f? What e�ects do di�erent values
of f have on the resulting image?

With the settings determined experimentally in this way, Part B of the experiment can be
carried out. Switch o� the room lights, turn on the laser and take a picture of the interference
pattern, using the remote trigger. In order to achieve the best possible results during the
evaluation, the intensities of the interference maxima of higher order should be as large as
possible, but without saturation of the CCD in the vicinity of the lower order maxima. In
order to be able to guarantee this, take a series of exposures while varying the exposure time
(texp ∈ [0.05 s, ... , 2 s]). From these images you will later determine the most suitable snapshot
for your evaluation.

Afterwards, switch o� all devices that are still in use (laser, camera, remote trigger) and
transfer your data from the SD card of the camera to a storage medium of your choice (a
device for reading SD cards is available on site). The part of the experiment taking place in the
laboratory is hereby completed.

3.3.2 Image processing and conversion

For image analysis and intensity measurements3, we will use the program Aladin4, a widely
used tool among astronomers. As our image still has the wrong �le format and also contains
super�uous information, some preparations are necessary.

The camera used here saves its RAW (i.e. lossless) images in .dng �le format, which we
convert for pragmatic reasons with the freeware Iris5, popular among amateur astronomers,
into a �le format suitable for Aladin. In astronomy, the Flexible Image Transport System
(FITS), developed more than four decades ago, still is the golden standard.

To convert a RAW �le accordingly, open Iris and load your image �le into the program via
�File → Load a RAW �le�. Note: Make sure you don't use the regular 'Open' dialog, as this will
result in an unwanted FITS �le output with multiple layers.

Preparation 5 Consider how color images are created in photography and research the purpose
of a Bayer matrix in the context of CCDs. What do you expect to see on the RAW image at the
position of the interference maxima? Do the observations match your expectations?

Before we save the �le as FITS, we will remove the information previously identi�ed as
super�uous from our image. In the case of a monochromatic image, this can be easily achieved
via binning of the individual 2× 2 Bayer elements. You can �nd this function in the menu tab
�Geometry → Binning�. In the dialog box that appears, select a binning factor of two to sum up
the pixel intensities of the individual 2× 2 areas. Finally, save your image using �File → Save�,
specifying FITS as the �le format in the Save dialog.

Perform the above procedure for each of your recorded images.

3Strictly speaking, what we measure here is the voltage tapped at the CCD, which corresponds to the number
of formed electron-hole pairs, i.e. a dimensionless quantity (typically referred to as counts). Since, under the
assumption of a constant detector e�ciency, this quantity is directly proportional to the intensity, we will adopt
the term �intensitiy� in the following sections for reasons of legibility, even though this is formally incorrect.

4https://aladin.u-strasbg.fr/
5http://www.astrosurf.com/buil/iris-software.html
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3.3.3 Image analysis with Aladin

The FITS �les generated in the previous section can now be examined in detail with Aladin.
This chapter serves to explain the basic functions of Aladin that are relevant here. The numbers
and letters in bold refer to the marked areas in the GUI (Figure 7).

Figure 7: Aladin's GUI. Areas marked in red refer to the respective references in the text.

Loading �les works simply via drag and drop. Drag your �le to the image layer area [A] at
the bottom right of the window. Quite possibly, Aladin has loaded an astronomical example
image on startup. You can safely remove this by selecting the corresponding image layer and
clicking on �Del�. [2]. Hint: You can easily have multiple images open at the same time in
Aladin. To do this, simply drag your additional �le(s) into the list of image layers. You can
display the contents of an image layer by ticking the check mark in front of the corresponding
layer. Please note the calibration instructions below!

For the upcoming intensity measurement, Aladin needs an astrometrically calibrated image.
Astrometry obviously does not play a role for our lab recordings, so it is su�cient to provide
Aladin with a �fake� astrometrical calibration. To do this, select the image to be calibrated
from the list and select the �Image → Astrometrical calibration� menu item [B]. The precise
values are irrelevant here, so you can simply leave the default values, and with a click on �Create�
in the newly opened window this step is �nished. Close the dialog window afterwards.

Important: The astrometric calibration must be performed as the �rst step after opening a
new image and for each image. If, for example, an intensity measurement is attempted with the
phot-tool prior to the calibration, any further measurements will fail and do not provide any
meaningful values. The only certain remedy then is to restart Aladin.

To the left of the image layers you will �nd a bar with various tools. To us, the �rst four
tools are most relevant, which are brie�y explained below:

� select [1a]: Allows you to select and move objects you have drawn (such as a distance
scale or a photometric aperture, see below), rescale and move them. If you want to select
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several such objects at the same time, simply draw a frame around them in the image
plane with the Select tool.

� pan [1b]: Moves the current image view.

� dist [1c]: A �ruler� for measuring distances in the image plane. Since in this experiment
we are interested in distances in units of pixels, we still need to select the appropriate scale
in Aladin. To do this, select �XY Fits� from the top menu bar next to �Frame�. [3].

� phot [1d]: With this tool you can de�ne a circular area on the image as a �photometric
aperture� and get a statistic about the intensities of the pixels within this area. This is
displayed in the lower right area of the window [C] and includes number of pixels, sum,
standard deviation, average and median of the intensities.

Finally, it should be mentioned that the representation of di�erent intensities is in principle
arbitrary and depends on the selected scaling function. Aladin uses a linear scale as default
setting. In order to make particularly faint features more visible on an image, it is useful to
increase the range the lower intensity values are mapped to. In Aladin you can do this with the
Pixel tool. For example, you can use the drop-down menu at the lower right edge of the dialog
box [D]; here the faint maxima will already stand out much more clearly by simply changing to
a log or arcsinh scaling.

3.3.4 Data selection

As mentioned above, for the intensity measurements we would ideally use an image with maxima
of higher orders as intense as possible, without saturating of the CCD at the positions of the
bright maxima of lower orders.

First, we want to get a feel for possible interfering factors for our measurements. For this
purpose, the (colored) RAW images are particularly suitable, which you can open with many
popular image viewing programs6. Take a look at one of the images with moderately long expo-
sure time (e.g. 0.5 s), paying particular attention to the area near the center of the di�raction
pattern. Do you notice any phenomena that could signi�cantly in�uence an intensity measure-
ment? Which maxima are particularly a�ected here?

Decide on the basis of these considerations, which maximum (preferably of low order) you
will use for the following task.

Use the phot tool to de�ne an aperture around the maximum you have chosen in a way that
you enclose it completely. Be careful not to choose an aperture that has too large an extent, as
the spaces between the major maxima are populated with several minor maxima of low intensity
(see Fig. 5). Note: If you load all images into Aladin before your measurement, drawing a
single aperture is su�cient. By switching to another image in the layer view, the apertures
created with the phot tool will be automatically updated when you select the appropriate area
on the image.

When you determine intensities in this way, your measurement will include not only the laser
light, but also additional background e�ects. Which such e�ects are known to you or do you
notice here? How can you approximately quantify these e�ects on the basis of your recordings
and correct your measurement data? Brie�y(!) discuss how it would be possible to improve this
correction. For this purpose, also research the terms �at-�eld, bias- and dark frame.

Exercise 3 Now plot the (corrected) average intensities as a function of exposure time. In which
range does a correlation present itself that corresponds to your expectations? Fit an appropriate

6e.g. IrfanView, https://www.irfanview.com/
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function in this range. How does the quality of the �t change if you include a longer exposure
time?

Since later measurements start with the �rst maximum, this likewise should not be saturated,
if possible. Take a look at the maximum you measured on the saturated and unsaturated images.
What di�erences do you notice?

Now combine your experiences and decide by eye at which exposure time you can perform
all measurements of the maxima n ≥ 1 without being a�ected by saturation e�ects. Justify your
decision.

3.3.5 Determination of the structure function

With the previous preparations, you now have everything you need to determine the intensities
of the maxima on the basis of an image with a suitable exposure time and compare them with
the structure functions given here.

Preparation 6 How do you calculate the standard deviation and standard error? And even
more important: what do these two quantities mean? How do they change if more measurements
are performed (e.g. 80 instead of 8)?

For the evaluation, the intensity measurements of the maxima of higher orders will be par-
ticularly relevant. Due to the weak intensities of the maxima around n ≈ 16, the orders of the
maxima (visible with suitable scaling, see above) in the range of interest cannot be determined
by �counting�. So a prediction must be made for the position of these maxima, which can be
accomplished utilizing the clearly detected orders n = 1− 9.

Exercise 4 Determine the positions of the interference maxima of orders 1-9. Give a realistic
estimate of your measurement error.

Note: Note that the di�raction pattern in your image will most likely not be perfectly parallel
to the CCD-rows of your detector and the higher-order maxima may have a signi�cant o�set in
the y-direction.

Then plot the distances of the maxima relative to a suitable reference point on a diagram and
derive a functional relationship by linear regression, which expresses the position of a maximum
as a function of its order. Can you improve your prediction using the maxima of higher orders?

Also, calculate the mean distance x̄ of two adjacent maxima. How can you ensure that the
error becomes as small as possible?

Now �rst measure the intensities of the maxima n = 1 − 9. To quantify the measurement
error, perform at least eight independent measurements of the �fth maximum, assuming that
this error is roughly representative of that of the maxima n = 1−9. Correct these measurements
analogously to 3.3.4 for background e�ects.

Using the positions derived from the previously determined function, you can also determine
the intensities of the weak maxima (n = 23 − 31). Provide an estimate of your measurement
error analogous to the procedure above, using the 27th maximum.

Exercise 5 Now plot the intensities in the diagram in Figure 8, normalizing your measured
values to the intensity of the �rst maximum. Note the additional error term due to the normal-
ization!

Based on the comparison with the given structure functions you can now decide which grid
with which line thickness was used in this experiment.
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Figure 8: Top: Structure function of the grid used in the experiment. grid. middle and bottom: Enlarged sections of the

top diagram.
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